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ACT! by Sage 2009 (11.1) – Product Improvements and 
Known Issues List – Release 
NOTE: This document is confidential and subject to your Non-Disclosure Agreement.  
 
ACT! 2009 (11.1) & ACT! by Sage Premium 2009 (11.1) are new releases in the ACT! 
product line and are referred to collectively as ACT! 2009 (11.1) in this document. The ACT! 
2009 (11.1) release is focused on improving usability of top task areas and allowing users 
to be more productive. This list is provided to improve your installation and overall use 
experience of ACT! 2009 (11.1). The issue numbers are internal tracking numbers and 
should be used when referencing issues to Sage Software employees. Please note, this 
document is provided to you as an ACT! Certified Consultant or ACT! Add-on Partner and 
must not be copied, reproduced, posted on your web site or distributed without express 
written permission from the Sage Software legal department. 
 

1 New Features in the release 
 
ACT! 2009 (11.1) Features: 
New and improved features in the 2009 Product Family are focused in the areas of Improving 
Usability and User Productivity in Top Task Areas as well as further Automating and Simplifying 
Installation. 
 
Contacts/Groups/Companies 
Relationships Tab - Allow users to "link" or create relationships between contacts 
Related Contacts allows users to document existing influential relationships between contacts in their 
database. For example, if Client A has an influential relationship with Client B, then I can store that 
information in the database to use in future sales or marketing campaigns, or be able to browse the 
information when I am looking up a particular contact. (61464) 
 
Enhanced Usability - New “Import Date” field 
To complement the “Is Imported” field on the contact, group or company records, a new “Import Date” 
field has been added to provide users visibility into last import event date for reporting purposes.  The 
field is available for lookups, reports and can easily be added to the layout using Tools->Design 
Layouts. (64411) 
 
Enhanced Usability - Last Import location 
During database import, the last location where users searched for their imported file is set at the 
default location to make it easier to locate the source database. (78487) 
 
Enhanced Usability - F6 toggles to previous layout 
Pressing F6 on the keyboard will toggle between the current and the previously used layout. (55970) 
 
Dashboards 
Enhanced Usability - Drilldown for specific bar and pie slice rather than the entire component 
This option allows users to drilldown the bar and pie slice by displaying the activities or opportunities 
associated with that slice.  A new menu item has been added to the component’s right-click menu – 
“View All Data in List” to show all activities or opportunities in a list view similar to the orginal drilldown 
behavior. (68863)  
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Activities/Opportunities 
Enhanced Usability - Activity Association with Companies 
You now have the option to remove the existing company association from an activity if you decide to 
reschedule it with a different contact. This feature enables you to keep your associated company 
information consistent with the contact’s company name. (62212) 
 
Filter Activity/Opportunity by Yesterday 
This feature enables you to filter your task list and opportunity list by selecting Yesterday as your filter.  
On the task list it will show all activities that have a start date of yesterday and opportunity list will 
show all opportunities that have yesterday as their expected close date. (75431) 
 
Enhanced Usability - Pop-ups on calendar items 
Calendar item tooltips will show multiple contacts if more than one contact is associated with the 
activity. (75946) 
 
Enhanced Usability - Company names in Alarm dialog 
Alarm pop-ups will display the company information for each activity contact in the list giving you a 
consistent calendar-like view of all activities.  This feature used to exist in ACT! 2000 (5.0) and has 
been reinstated in the current release. (74389) 
 
Enhanced Usability - Go To multiple selected alarms 
As part of the standard ACT! workflow for performing a lookup and working within the list, the Go To 
button on the alarms dialog will take you to the list of contacts associated with all selected activities.  
The alarms dialog will remain open while your list view changes in the background. (70367) 
 
Attachments 
Enhanced Usability - Mouse-over on Attachments and Documents shows physical filename 
In order to improve discoverability of attachments, the tooltip for selected attachments will now show 
the complete physical path to the actual file. (75411) 
 
Histories 
Enhanced Usability - Edit “Regarding” list when recording new history 
Users can now edit the “Regarding” dropdown from within the new history dialog the same way as 
when scheduling a new activity. (70672) 
 
Enhanced Usability - History icon on Toolbar 
To give further accessibility into history creation, a new History icon has been added to the standard 
toolbar so users can quickly create histories regardless of what view or layout they are current using.  
The history dialog pops up with the history automatically associated to the last contact that was viewed 
on the contact detail view.  Users have the option to change history association any time prior to 
clicking OK. (78475) 
 
Installation 
Enhanced Usability - Improved installation experience 
Significant changes have been made to enhance the overall installation experience.  Users are given 
two options to perform installation – “Typical” and “Custom”.  It takes fewer clicks to complete a typical 
install providing a consistent and friendly feedback to users during the install process.  Custom 
installation provides much more accessibility into install options for customized settings. (78184, 78782, 
72153, 78410, 79959) 
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Licensing/Activation 
Activation behind proxy 
If a proxy server is detected during the registration process, a dialog is displayed to enter user name 
and password in order to connect and activate through the proxy server. (79854) 
 
Mail Merge 
Enhanced Usability - Sticky options settings 
All mail merge wizard options are “sticky” when the user clicks the Finish button.  This reduces the time 
required to do subsequent mail merges if the options are same as the first time. (78481) 
 
Preferences 
Default Backup location preference 
A new preference is available for users to specify the default backup location in the preferences dialog. 
(57751) 
 
 

2 Fixed Issues 
 
Microsoft Outlook® Integration 

• ACT! to Outlook calendar copy did not update the free/busy calendar in Outlook at the end of 
calendar-copy for recurring activity day instances until the appointment is opened and re-saved 
inside Outlook. (59123) 

• Previously, Outlook e-mail attach to contacts feature (including Outlook rules) matched 
contacts using the contact name instead of the e-mail address.  This has been addressed to 
follow a consistent contact matching standard for both “Quick Attach” and “Attach to ACT! 
Contacts” options.  For “Quick Attach”, if multiple contacts consist of the same e-mail address 
on any e-mail type field, the e-mail will be attached to all matching contacts.  If no matching 
contacts exist with the same e-mail address a new contact will be created.  For “Attach to ACT! 
Contacts”, the contact picker dialog will be pre-populated and pre-selected with all matching 
contacts in the database. (78355, 77185) 

• Items in the ‘Not Attached Messages’ tab in the Quick Attach Progress UI were incorrectly 
displayed by duplicating the information in the “To:” or “From:” fields. (78864) 

• Images embedded inside an ACT! e-mail template appeared as attachments when sent via 
Outlook with Word as the e-mail editor. (78837) 

• Last e-mail field did not update when e-mail history was set to “Attach to Contact” (77891) 
• History was not recorded if a user performed a mail merge immediately after installing ACT! 

2008 until ACT! was restarted at least once. (5409) 
• E-mail Attach to Contact behaved differently when e-mail was attached to contact from within 

Outlook Inbox vs. opened e-mail window.  In the latter case, only history was created with 
subject but the e-mail was not attached. (79833) 

• Outlook Add-in failed to load when SQL service was disabled because it was trying to access 
the database engine and timing out. (79265) 

 
Mail Merge 

• When creating a new Mail Merge template or editing an existing Mail Merge template, the Mail 
Merge UI was not present for the following configuration: Windows Vista 64-bit with Microsoft 
Word 2003. (78948) 
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Fixed Issues Continued: 
 
Printing 

• Calendar Quick-print did not include the calendar title bar to clarify the day, week or month 
that the calendar belonged to, for example “October 2008” or “Monday, October 13, 2008”. 
(69432) 

 
Synchronization/Remote Databases 

• Only a few controls inside the Sync Panel accepted keyboard typing as input. (78467) 
• Users used to get message “ACT! Network Sync Service is unavailable. Please install the service 

to run sync server” when the Domain/Workgroup for the machine hosting the Network Sync 
Services was changed. (5962) 

• In some cases, Address and Phone fields did not synchronize between main and remote 
databases. (80090) 

• In some cases, remote databases stop synchronizing with the publisher because sync 
watermarks do not advance. (82114)  

 
Contacts/Groups/Companies 

• No message existed to warn users that private contacts belonging to a user will be lost when 
that user is deleted.  The message has been added in this release. (76240). 

• Update Company-Contact Linked Fields did not function when spillover table fields are linked to 
a company. (78515) 

• Tabbing into Date field on Contact layout changed the date value back one day if edited in a 
later time zone. (76318) 

 
Activities/Histories/Notes 

• Activity and History Records could not be deleted if they had a read-only file attached. (62400) 
• Incorrect activity count was displayed on the calendar’s status bar due to timeless and 

recurring activities. (79744) 
• Group and Company activities tab did not apply the correct user filter based on the selected 

user. (79704) 
• Last attempt field did not update when manually creating a call history with “Call Left Message” 

status. (79261) 
• History type filter did not display all histories with e-mail history types in the history grid-view. 

(79451) 
• When scheduling a new activity from Task List, the “Schedule With” was set to the contact 

associated with the arbitrarily selected task as opposed to contact in the detail view. (80165) 
 
Dashboards 

• The Opportunity by User component incorrectly showed the custom sales cycle stages in the 
legend when the ACT! Sales Cycle was selected as the filter. (77899) 

• When designing a new dashboard, an error message “Value cannot be null” was displayed if 
custom date range was chosen for default dashboard filters. (79761) 
 

Opportunities 
• RTF formatting in opportunity details did not save correctly when opportunity was closed and 

reopened. (77734, 77115) 
 
Preferences 

• Default history creation preference was not retained when using ACT E-mail as client. (79231) 
• Newly created custom activity types did not show up in the scheduling preferences dialog. 

Confidential – Do Not Copy 
© 2008 Sage Software, Inc. All rights reserved. 

 Page 4 of 10 

 



ACT! 2009 (11.1) 
Release Overview 

12/15/2008 

(78235) 
 
Fixed Issues Continued: 
 
Excel Integration 

• Map to Excel on the documents tab did not work with group and company fields and displayed 
an ambiguous error message. (79869) 
 

Import 
• Spillover fields were not listed in the destination fields dropdown on the Import Wizard 

mapping page. (79578) 
 

Other 
• In some cases, customizing columns in list views and tabs did not retain settings (74559) 
• Schema update from ACT! 2007 (9.0) to ACT! 2009 (11.0) caused exceptions. (79544) 
• In some cases, check and repair within ACT! caused database error.  Now, users will get an 

option to perform a more extensive repair with potential data loss, or call tech support for 
further assistance. (79078) 

• Custom defined multi-select dropdown lists sometimes added additional values if several items 
were selected by default, causing the list to show more than what was available. (78527)  

 
 
 

3 Known Issues – New in this release 
 
This list encompasses most frequently encountered items in ACT! 2009 (11.1) that were found in the 
current release.  The known issues include a description along with any identified workarounds or 
recommendations.  
 
Contacts/Groups/Companies 

• Current Company lookup is not retained after any Define Field change is performed for the 
company fields. (79845) 

o Workaround: Perform the company lookup after doing the Define Field change. 
• Note:  In upgrade scenario, “Relate Contact” menu item is missing from the Contacts menu. 

(81047) 
o Workaround: contact relationships can be formed by using the toolbar button on 

“Relationships” tab. 
 
 
 

4 Known Issues – Existed in previous release 
 
This list encompasses most frequently encountered issues in ACT! 2009 (11.1) that were present in a 
previous release.  The known issues include a description along with any identified workarounds or 
recommendations.  
 
Activities/Notes/Histories 

• Timeless activity dates changes to previous day if users are in different time zones. (79888) 
o There are no issues with timeless activities when all users in the same time zone. 
o Example for when an issue occurs: 
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 A user in the EDT time zone schedules a timeless activity for 5/30 
 A user in the PDT time zone (-3 hours from EDT) will see this activity 

scheduled for 5/29 due to the time difference of -3 hours between EDT and 
PDT which shifts the activity from 5/30 12:00 AM to 5/29 9:00 PM. 

• Consecutive addition of histories causes memory usage to rise when hundreds of histories are 
added.  

o Workaround: Restart ACT! or PC after adding hundreds of history records. 
• Logged in user's activity records are displayed when filtered specifically by that user, but not 

when filter is set to "All Users". (78819) 
o Workaround: set the filter criteria to single user so only that user’s activities are 

shown on the calendar. 
 
Install/Uninstall/Setup/Startup 

• When uninstalling ACT! 2008, users need to uninstall Microsoft® SQL Server®™ 2005 Express 
Edition from add/remove programs in order reinstall ACT! 2006 (8.x) or 2005 (7.x).  

• On Windows Vista® operating systems, you must Run As Administrator when performing an 
ACT! Update, sharing a database, using the Scheduler or Registering the product. 

o Workaround: To run as Administrator, right mouse click on the ACT! shortcut and 
select “Run as Administrator.”  

 
Conversion/Import/Export 

• User can map fields into fields that are read-only, but data is not imported. (56512)  
• When importing contacts with ‘Replace with Source Contact” option, the first and last name are 

no longer parsed. 
 
Outlook Integration 

• Microsoft changed the design of meeting invitations with Service Pack 2 for Outlook 2003. 
When a user accepts or tentatively accepts a meeting, either from a meeting request or from a 
calendar item, the existing calendar item is deleted from the calendar. Additionally, a duplicate 
of the calendar item is created for the deleted item. Duplicate activities are created in ACT! 
when a user accepts or tentatively accepts a meeting in Outlook.  

o Workaround: By default, this new meeting acceptance behavior is enabled in Outlook 
2003 SP2. However, the behavior can be disabled or re-enabled by using a registry 
key. Detailed information about how to disable or re-enable the registry key can be 
found at http://support.microsoft.com/?id=899919. (6619) 

• Bi-weekly reoccurring Sunday events copy incorrectly to Outlook calendar. (80119) 
o For Example: 

 Create a recurring activity on October 5th to occur every two weeks and copy 
calendar to Outlook 

 Activity shows up on Outlook Calendar on October 12th and 26th. 
• ACT History options are not available on the e-mail dialog when performing File->Send to-

>Mail Recipient inside a Word Document. (79583) 
• Business Address 1 field does not map to the correct Outlook address field when a contact is e-

mailed as an ACT! VCard and then opened inside Outlook on the receiving end. (80013) 
 
Contacts/Groups/Companies 

• Note: Updating linked contacts for a company is designed to update all linked contact fields 
with the content of the company record on any change of the company record. That means 
that the content of ALL linked contact fields is replaced with the content of the linked company 
fields, including blank fields, whenever any of the linked company fields changes. (56555) 
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• Required contact fields can be left blank if contact is created from a Company record (77078, 
80311) 

• In some cases for Group and Company detail view, when you select the contact or opportunity 
tab the Tools->Customize Columns menu item is disabled. (80106) 

o Workaround: Display the "Customize Columns" dialog via the Options control on the 
tab's tool bar. 

• The context menu for the Record Manager field does not contain the option to perform lookup 
using record manager as criteria. (79342) 

o Workaround: Use Lookup -> Other Fields, then select the Record Manager field in 
the Lookup Contacts dialog. 

• Search Option in Group and Company List views does not have a consistent look-ahead 
functionality as the Contact List view. When typing characters in the textbox, it replaces 
previously entered characters with new keystrokes instead of perform lookup using existing 
characters. (79616) 

 
Lookups 

• Lookup on the secondary contact field retrieves incorrect number of records. (79845) 
 

Synchronization/Remote Databases 
• On Windows Vista operating systems, you must Run As Administrator when creating a Remote 

DB 
o Workaround: to run as Administrator, right mouse click on the ACT! shortcut and 

select “Run as Administrator.”  
• Notes that were deleted on one remote database do not sync to the second remote in a 

multiple remote database synchronization scenario. (78490) 
 
Mail Merge 

• Memo fields added to “.tpl” Templates lose formatting when merged to e-mail. (80034) 
• An image added to a fixed location on a mail merge template does not appear on all pages 

when the mail merge is performed. (79831) 
o NOTE: this only occurs when the image is part of the header. 
o Workaround: remove and re-add the image to the header so it gets included on all 

pages.  
 

Reports 
• An error is displayed - "Index was outside the bounds of the array", if the Vertical Spacing 

option is selected to align fields when creating new report from template. (79168)  
• When adding a Contact Activity type field to a new Report Template, the Contact field is not 

present in the dialog showing list of available fields. (78872) 
• Picture fields do not display when used in reports. (81027) 

 
Installation 

• Over install of ACT! 2009 (11.0) opens with a minimized window pinned to the upper left 
corner of the screen.  New installations and patch installs do not have the same problem. 
(79209) 
 

ACT! Log Viewer 
• ACT! Log Viewer cannot display in html.  If you click the ‘convert to HTML’ button an error will 

occur (78606). 
 
Other 
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• Some filter drop-down lists can become truncated and the last item in the checkbox list may 
not be accessible (a scroll bar may not be present).  This issue exists on the following filter 
drop-downs: Contact Activities tab (‘type’ & ‘priority’ filters); Group Activities tab (‘type’ filter); 
Task List view (‘type’ & ‘priority’ filters); Calendar view (‘type’ filter); Opportunity List view 
(‘stage’ filter) (77884). 

o Workaround: Click on the check box for the last item in the drop down list or select 
‘None’ at the bottom of the drop-down, and the scroll bar will (re)appear. 

• Users are unable to attach a Web page to an ACT! contact in a Citrix environment using the 
“Attach Web Page to Contact” feature. (71256) 

o Workaround: Save page locally and then attach it as a file.  
• In some case if upgraded from ACT 6.0 to ACT! 2008, sending e-mail from ACT! crashes Lotus 

Notes. (79170) 
• Setting DPI to 120 truncates buttons and text in the conduit configuration wizard for Palm Link 

and Pocket PC Link. (78999) 
 
 

5 Compatibility 
 
ACT! for Palm OS 
ACT! for Palm OS® 3.0 is not compatible with ACT! 2009 (11.1).  ACT! 2009 (11.1) will not install on a 
machine that has ACT! for Palm OS 3.0 installed. 
 
ACT! SDK 
A new version of the ACT! SDK is available with ACT! 2009 (11.1).  Refer to the SDK documentation for 
framework API and code samples. 

 
ACT! 2009 11.0 
ACT! 2009 (11.0) users cannot share the same database with ACT! 2009 (11.1) users. All users in a 
workgroup must be on the same version to access and take advantage of the new release.  
 
Mixed ACT! Premium and ACT! Premium for Web Environments 
ACT! Premium and ACT! Premium for Web users who share a database must also be on the same 
version number in order to access and share data. Administrators for these mixed environments should 
wait to update to ACT! 2009 (11.1) until both web and windows versions are available.    
 
Synchronization Services 
If synchronization is employed, and any users are on version ACT! 2009 (11.1), the sync service must 
be upgraded.  
 
Note: Updated Sync Services are included in the full ACT! 2009 (11.1) product download.     
 
How To Apply The Microsoft® SQL Server™ 2005 Service Pack 3 
Refer to KB article number 21104 for instructions on how to apply SQL Server 2005 Service Pack 3 to 
the SQL ACT7 instance that is installed with ACT!.   
 
Note:  The SQL Service Pack utility available on KB site only applies to the International English 
versions of ACT!. 
 
ACT! Update (Release Candidate) 
If you have previously upgraded to any release candidates of ACT! 2009 (11.1) during the product 
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phased release, you must uninstall the release candidate prior to installing the “Gold” version of ACT! 
2009 (11.1).   

 
 

6 Other issues fixed in ACT! 2009 (11.1) 
 
This list encompasses most frequently reported customer and partner issues that were fixed in ACT! 
2009 (11.1) and not covered in any of the previous sections. 

 
Defect 
Number  

Title  Feature 

81061  User's history queue does not get set for subsequent users  Citrix/Terminal Server 
80684  Assigning a different drop down list to an existing field does not sync 

to remote 
Synchronization 

80670  Synchronisation fails due to an out of memory error on the server 
Exception of type 'System.OutOfMemoryException' was thrown. 

Synchronization 

79509  Regarding & Details column in History tab only displays Details if in 
the standard position on the grid 

Contacts 

77949  Contact Save does not work in Edit Mode unless you change to a new 
field 

Contacts 

80897  Custom menu commands that contain dropdowns, duplicate list 
items after closing/reopening ACT 

Menus/Toolbars 

80715  In German regional settings, recurring activities copied to Outlook 
show up on the wrong day 

Outlook Activity Sync 

80449  Importing VCard doesn't import addresses  Import 
80381  Manage handheld sync set does not work via ACT! Link settings  Synchronization 
80369  When sending and attaching Emails to Contacts, 'From' user 

information does not get added to E‐mail History 
E‐mail 

80183  ‘Email record history type’ value can be modified by manual typing 
when mail merging to email 

Mail Merge 

80140  When creating a new Opportunity on a Contact List View, the 
opportunity is associated with first record in the list regardless of the 
selection 

Opportunities 

79633  Errors occur when merging to more than 115 contacts with 
spellcheck enabled in Word 

Mail Merge 

79580  Yes/No fields behave eratically in Contact List when using Edit mode  Contacts 
79460  Email attachments show attached date not sent date when attaching 

emails to contact using Outlook 
Attachments 

78238  Opportunity Pipeline graph counts opportunities with multiple 
contacts as separate opportunities 

Reports 

76522  Quotes are not populated when regional settings are Swedish 
(Sweden) with a database currency set to Swedish Krona 

Opportunities 

80271  Alt+Down Arrow does not open the calendar dropdown when 
scheduling an activity 

Activities 

79913  E‐mail registration response has grammar error  E‐mail 
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79713  Use Dialer preference do not disable after unchecking  Dialer 
79708  Internet Services in Premium for Windows and Standard point to an 

invalid URL in UK region 
Internet Links 

78703  Date range in Task List filter does not behave as expected  Task List 
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